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1. Welcome to COPA-DATA help

GENERAL HELP

If you cannot find any information you require in this help chapter or can think of anything that you
would like added, please send an email to documentation@copadata.com
(mailto:documentation@copadata.com).

PROJECT SUPPORT

You can receive support for any real project you may have from our Support Team, who you can contact
via email at support@copadata.com (mailto:support@copadata.com).

LICENSES AND MODULES

If you find that you need other modules or licenses, our staff will be happy to help you. Email
sales@copadata.com (mailto:sales@copadata.com).

2. Driver simulation

If the underlying process is not available when configuring, this can be simulated and tested in advance.
Three modes are available for this:

» Simulation static (on page 6): constant values simulated by the driver
» Simulation - counting (on page 6): values simulated by the driver are counted up

» simulation - programmed (on page 7): Values are calculated via a simulation project with straton
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A Attention

If the driver is stopped in mode Simulation - counting, only the counting is stopped.

The variable is not switched to faulty. In all other modes the driver is really stopped.
Note: simulation - programmed is not supported by drivers for:

» Internal variables
»  Mathematical variables
> Simulator variables

> System variables

¥ Information

zenon variables which represent the straton IO variables are available in the project in

state Driver simulation programmed.

3 License information

Part of the standard license of the Editor and Runtime.

3. Simulation static

For a static simulation, no communication to the control is established; the values are simulated by the
driver. In this mode the value remains constant. Values can be changed by the Runtime or the user. At a
restart of the Runtime with simulation - static theses values will however not be saved and are lost.

4. Simulation - counting

For a counting simulation, no communication to the control is established; instead the values are
simulated by the driver. In this mode, the driver increments the values within a value range



automatically, starting with 0. If the maximum value has been reached, the counting process starts at 0
again.

¥ Information

For negative starting values, the counting process only starts at 0.

INT uses the maximum value from USINT to count.

& Attention

If the driver is stopped in mode Simulation - counting, only the counting is stopped.

The variable is not switched to faulty. In all other modes the driver is really stopped.

5. Simulation - programmed

For Simulation - programmed, no communication is established to the PLC; instead, the values are
calculated by a freely programmable simulation project. The simulation project is created with the help
of the straton Workbench and runs in the straton Runtime. It enables the status and time stamp of
variables to be modified on the driver. Write commands to variables by zenon are forwarded to the
simulation, redundant servers and Standby Servers are synchronized. This is how you also simulate
complex processes.



To start the simulation program, select the Simulation - programmed mode in driver configuration (on
page 14).

Allgemein | Settings

oK
Abbrech
Modus: il
[ Update-Liste im Speicher Hatten
[ Ausgange schreibbar
[ Variablenabbild remanent
Update Zeit Global

Globale Updatezeit in ms:
1000

Prioritat

¥ Information

Windows CE

Simulation - programmed is not available for Windows CE.

5.1 Editor

5.1.1 Create project
To create a program for Simulation - programmed, you must:
» select a single process driver

» make sure that the project name is valid.

& Attention

Simulation - programmed is not supported by drivers for:



» Internal variables

»  Mathematical variables
»  Simulator variables

> System variables

To create a simulation project:

» clickinthe group Driver simulation project inthe property Edit on Click here ->
» A new straton project is created.

» Name and port numbers for Event port and Standard port are automatically issued;

change these as you wish

» the straton Workbench is opened

The simulation project's workshop is automatically closed if:
» the zenon editor is closed
» adriveris deleted and its simulation project is currently being edited in Workbench
» the simulation project for the driver is deleted via the Delete property

» the simulation project is renamed

PROJECT ARCHIVING

A straton project contains many files and folders. To manage them, in particular to simplify distributed
engineering, all files are archived in compressed form in the simul_<Treiber-ID>.zip file in the
<Sgl Projekt Pfad>\FILES\zenon\custom\drivers. Thisfileisinthe driver filesin the
editor. When starting straton Workbench, the files are automatically decompressed are compressed
again when it is ended.

CREATING VARIABLES

When creating variables in a simulation project, the succession is important:
1. create the variable
2. select the valid data type in the straton Workbench

3. after that activate property embed symbol



Background: Variables are created with the PLC marker driver object type by default. This object
type does not support all data types for all drivers. If a variable is copied in the straton Workbench with
active property embed symbol, you must deactivate this property in order to change the data type.
With this the variable is then deleted in zenon.

¥ Information

Error message "Can not create variable"

A variable cannot be created in the simulation object if the driver does not have driver

object types - exception
driver variable - wWhich support this data type.

On activation of embed symbol, the error message "can not create variable" is

displayed.

STRUCTURE DATA TYPES

At creating variable with a structure data type:

» they are created with the driver object type PLC marker if possible

» all driver object types with the exception of driver variable are tried until one can be used for

all elements

» if no fitting driver object type is available,
e no variable is created for non-structure variables

e driver object type PLC marker is used for structure variables

EXAMPLE:

A structure data type contains elements of type UINT and STRING. A variable is created for S7TCP driver
and embed symbol is activated.

» The variable is not created in PLC marker butasExt. Data module, in which all structure

elements are present.

» A new type LINT is added; it is not supported by the Ext. Datablock.

10



» When a new variable is created, it is created as type PLC marker. Only the first complex
variable can be activated (UINT). The object type Ext . remains for the existing structure

variable Data and the last structure element (LINT) cannot be activated.

COMPILING THE FILES

If a simulation project is compiled in straton Workbench, this causes a variable to be created in zenon
and the Runtime program file.

When compiling, a subfolder is created in Runtime-Folder\RT\FILES\zenon\custom\drivers with the
name of the simulation project. The file with the code of the simulation is SIMULRT.COD is archived in
this folder.

The following message is displayed in the output window:
SIMULRT.COD
And if compiled with the C compiler, then also:

TS5APP.DLL

& Attention

For multi-user projects (on page 12) you must not create simulation projects

offline. They cannot be deleted anymore.

5.1.2 Delete project

To delete a simulation project:

1. clickonthe click Here-> buttoninthe Delete propertyinthe Driver simulation

project group
2. confirm this when requested to do so
3. the ZIP file with the project files is deleted

4. the straton Workbench is ended

Note:

11



» the Runtime folder for the simulation project remains
» function undo is not available for this action,
» clickon Edit to create a new simulation project

» formulti-user projects (on page 12):

e the driver must be configured t0 Make changes possible SO that the simulation
program can be deleted

o the project is not displayed as deleted on other Clients as long as it has not been
synchronized,;

if you try to open a deleted project before it has been synchronized (click on Edit), a
new simulation project will be created

e you cannot reverse the deletion of single-user projects via cancel changes

A Attention

The Simulation project is immediately removed from the local database and the server

database when deleted. This action cannot be undone!

Note: Manual deletion of the ZIP file of the driver also leads to the simulation project being deleted.
Requirement: The straton Workbench for this driver is not opened. We do not recommend doing it this
way!

5.1.3 Distributed engineering

Formulti-user projects, all running straton Workbenches that are part of the project are closed
when:

» Accept changes for modules that are completely locked for other users in Enable changes,

such as variables, drivers and data types

» Discard changes:
e new projects are not created on the server
e Changes in the simulation program are lost
o Driver files not present in the server database are also lost in the local database

» Synchronize:

changes made locally to the simulation program program are lost

12



» Update local version:
changes made locally to the simulation program in the simulation program are lost

A Attention

The status of the simulation project's  ZIP file may not be additionally
modified(Accept Changes, Enable Changes, Discard Changes
multi-user status), to ensure correct Accept Changesand Enables Changes

for the driver!

DELETE PROJECT

For multi-user projects

» the driver must be configured to Make changes possible so that the simulation program can be

deleted

» the project is not displayed as deleted on other Clients as long as it has not been synchronized;

o if you try to open a deleted project before it has been synchronized (click on Edit), a
new simulation project will be created

» you cannot reverse the deletion of single-user projects via cancel changes

& Attention

A simulation project with the status of Enable Changes cannot be deleted (on
page 11) in Of f1ine mode.

A simulation project created of f1ine in amulti-user project can therefore no
longer be deleted.

5.1.4  Change driver

For a driver change in zenon the following is true:

» The simulation project is maintained.

13



» All ports are however set to 0. To receive working port numbers, open the project in the Editor.
At this new port numbers are entered automatically. Port numbers can also be assigned

manually.

A Attention

Drivers that are linked to a straton project using the integrated solution cannot be
exchanged.

5.1.5 XML export/import

A project in mode Simulation - programmed can be exported via XML. It can however not be imported as

new project for another driver.
Workaround:
1. Export the straton programs.
2. Import them to the new project for the new driver.

3. Replace the variables via search and replace.

5.2 Driver configuration

There are four modes available when configuring the driver:

» Hardware
» Simulation - counting
» Simulation static

» Simulation - programmed

14



Select the simulation - programmed mode.

Allgemein | Settings

Modus:

[ Update-Liste im Speicher Hatten

Ig[
S
g

[ Ausgange schreibbar
[ Variablenabbild remanent

Update Zeit Global
Globale Updatezeit in ms:
1000

Prioritat

5.2.1 Driver variable status

The status of straton is shown in the driver variables SimulRTState at Offset 60. The variable is numerical
and cannot be written to. The value informs you of the status of Runtime:

15



Bit
31

30

18

17

16

15

14

13

12

11

10

Meaning

without application

not instanced

p-code available

compiled code active

compiled code available
application is loaded

can't start - missing handlers
active breakpoints installed

CT segment exists

Reserved

sysinfo request is available
freeze event production
single cycle mode

Reserved

locked variables

trigo functions are in degrees
log message(s) in stack

application stopped between 2
progs

application stopped on SFC breakpt
application stopped on error

application is running

Description

Runtime has not loaded a program, the program was stopped
or not loaded to Runtime.

Runtime was not instanced, for example because the DLL with
Runtime could not be loaded, there is too little memory, the
DLL is not present or is the wrong version.

p-code is available together with compiled code, switching is
possible.

Runtime runs with compiled code (otherwise: interpreted
p-code)

Compiled code from the C compiler is available
An application is present, Runtime is running
Some "C" functions are missing

At least one breakpoint was set by the debugger.

Application was compiled with the "complex variables in
separate segment".

(internal, for Runtime only.)

(internal, for Runtime only.)

Binding does not transmit events.

(intern, for Runtime and debugger only.)
(internal, for Runtime only.)

At least one variable is blocked.
Trigonometric functions are stated in degrees.
(internal, for Runtime only.)

Runtime stopped between two steps during debugging

(internal, for Runtime only.)
Runtime stopped with a serious error, restart required.
TRUE = application is in "run" mode.

FALSE = application pauses in "cycle to cycle" mode.
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¥ Information

The driver variable SimulRTState with Offset 60 displays the status of Runtime on the

server. This is also true when the variable is displayed on the Standby.

5.2.2  Cyclical synchronization

Simulations run in a network on the server and Standby Server independently of one another. When the
Standby Server starts, there is a synchronization with the server, however:

» This first synchronization is postponed by the packet runtime

» Small differences in the execution lead to growing diversion

The status of the simulated variables also therefore becomes different. In order to keep these
differences low, use the Transfer driver simulation image to standby to synchronize the simulation
image:

» create a new function

17



» Select Transfer driver simulation image to standby

Select a function
Functions selection
@ i Message Control -
-y Network
+-[#] Recpes
&| Report Generator
- ® soeens
£ Script
t -8, User administration
. Variable
i &) Driver Commands
~Q Bxport data
-G} HD administraton active
i £} HD administraton inactive
L3 Print current values
i) Read dBase file
&3 Read time from variable
-G} Send value to hardware
9
¥ Trend-values on/off
1} Q Unit conversion
& writs time to varizble
445 VBA
-9 VSTA
+- Windows -

5B

m

Quick help
Internal ID: FKT_VAR_ALIGN_VM_IMAGE

Transfer driver simulation image to the standby

Is only carried out at the Standby.

Demands an image for the selected drivers from the server
when it is executed. The driver has 5 seconds of time for
this.

More in the online help

o || e [ e |

» The dialog to select the driver opens

Transfer driver simulation image to iby

Drivers which must be synchronized |

it |

ok
Driver % —
STRATON32 [ straton: Project

[] s7TcP32 /ST TCP-IP Help

» Inthe list, all process-connected drivers (with the exception of the simulator) are available

(clicking on the column heading changes the sorting)

» Select the driver that is to be synchronized

18



» Each time a function is called up on the Standby Server, an image is requested from the server

for the selected driver

The differences in the current simulation status can be minimized through cyclical activation. Adapt the
grid of the execution to the extent of the data to be synced, because this places a load on the network
and computer.

The Execution of the function is set at Standby Server and fixed; it cannot be changed. It only
happens if:

» The computer is the Standby Server
» The Server is online
» The project is a network project

» Drivers were selected for syncing

TO CHANGE THE SELECTION OF THE DRIVERS

» Inthe driver properties, click in the General group in the Tag properties

» The dialog for selecting the driver opens

5.3 straton Workbench

The simulation - programmed is programmed in the in the straton Workbench, which works in close
conjunction with the zenon Editor. For the simulation, (in contrast to the integrated solution) only the
variables of a driver are exchanged between the editors.

DEFINITION OF THE VARIABLES TO BE EXCHANGED:

When starting straton Workbench, all driver variables that are not yet present in straton are created as
global variables. The Embed symbol is automatically activated for these.

VISIBILITY

If a new variable is defined in Workbench in the global or retain area, this is only visible in straton. To
make it visible in zenon too, the Embed symbols option must be activated. From this point in time, all
variables are updated by both editors.
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If the Embed symbol option is deactivated, the variable is deleted in the zenon editor. This action
enables global or retain variables to be defined in straton, which are not visible for zenon.

For a newly-created variable created by the straton Workbench in zenon, an attempt is made to assign
this to the SPSMERKER area. In the event that the zenon driver (on page 8) does not support the
configured data type, a search is made for the first data area that supports the data type. If no area is
found, the variable cannot be created.

A variable is only locked if in the case of a multi-user project and the enable changes status has
not been set.

PROJECT SETTINGS

Some settings under Project -> Project parameters... >-Further options-> Extended in straton influence the
functionality of the simulation.

20



Extended settings

Runtime: execute mode

compiler/options: Embed
symbols of all variables

compiler/options: Retain
capitalization of
symbols

compiler/options: Create
status bits for variables
with a profile

"C" compiler

5.4 Runtime

54.1 Functionality

Description

Recommendation:
Mode: triggered

cycle time:1/4to 1/3 of the driver update time
for frequent value changes to simulated variables lead to increased
load placed on the computer.

Recommendation: Deactivate.
Active: Data for avariable are exchanged, because the symbol
names are assigned in Runtime.

But: Changes to the configuration of the variables are not updated
between zenon and straton. It is no longer possible to make changes
online.

without effect: Variable names are always converted to capitals in
Runtime.

Active: The status of variables is simulated or reacted to in the
simulation program.

Native code is supported.

Name of the DLL that the compiled code must contain:
t5app.dll.

straton Runtime offers the following functions:

» File transfer

» Data types:
e« BOOL
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« BYTE

e DINT

« DWORD
e INT

e LINT

e LREAL
¢« REAL

e SINT

e STRING
e TIME

e UDINT
e UINT

e USINT
¢« WORD

zenon arrays (see also Arrays and simulation (on page 23))
Date stamp/time stamp

Digital recording of values

Dynamically linked function blocks, stored in t5block*.d11

Hot Restart

Logging:
e Trace messages from the program (printf)
e Error messages in Runtime

o all sent to Workbench and to the diagnosis server

Machine code: Native compiled code with C post compiler (not available under Windows CE)

Online Change
Programming languages: IL, AS, FDB, LD, ST
Retain Data (remanant Data)

Special function blocks and features:

o Data serialization

22



e dynamic memory allocation
e embedded recipes
e embedded variable lists

e File Management

e Files

e Math

e Random
e Signals

e String tables
e Trigonometry

e Time

» Spontaneous communication
e Value change as an event
e 16 connections

e Hysteresis
» UDP & TCP/IP for IEC languages

» Variable interlocking

5.4.2  Arrays and simulation

To simulate multidimensional arrays at driver simulation, you must activate property 'Save complex
variables in own segment' in the straton Workbench.

ARRAYS WITH START INDEX 1

If at a simulation arrays with start index 1 exist, these arrays are created with one more index in the
straton Workbench.

#  Example

In zenon an array has indices 1 to 4. This array has the indices O to 4 in the straton
Workbench.

23



This guarantees that the same indices are used in zenon and in straton. Index 0 is not transferred to the
driver.

If you change array in the straton Workbench, you must consider this additional index.

5.4.3 Runtime files

When creating the Runtime files, a subfolder with the name of the simulation project is created in the
Runtime folder of the projectin the path \RT\FILES\zenon\custom\drivers. The file with
the code of the simulation is simulrt.cod and is archived in this folder.

Once successfully compiled in the Workbench and transferred to the Runtime folder, the following
message is shown in the output window of the Editor:

SIMULRT.COD

And if compiled with the C compiler, then also:

T5APP.DLL

REMOTE TRANSPORT

The Runtime files for the simulation are created as a subfolder of the driver files. For remote transport,
the and all information contained in it is transferred to the target computer

5.4.4 Data exchange

The exchange of data from straton Runtime to the driver starts with the 2nd cycle of straton Runtime.
Therefore the first run is available to initialize all variables in Runtime.

Data is only exchanged if:

» The variable is requested and:
e did not yet receive a value

e does not have the status Switched off (OFF/_VSB_N_UPD) or Alternate
value (ALT_VAL/_VSB_AVALUE) in the driver

e s still required by the driver.

e has changed value or status

24



The exchange of data to the driver is carried out asynchronously to the Runtime cycle. The driver runs
through the value changes once per update cycle. All values changed - with the exception of the
Switched off (OFF/_VSB_N_UPD) or Alternate value (ALT_VAL/_VSB_AVALUE) status - are
entered into the list of variables to be updated in the driver and sent to Runtime.

TRANSFER DRIVER SIMULATION IMAGE TO STANDBY FUNCTION

This function is only executed on the Standby Server (for configuration, see Cyclical comparison (on page
17) chapter). The data is synchronously fetched from the driver on the server that is compiling the
image. The driver has 5 seconds of time for this. Because the data for the image is created in the same
thread in which the simulation is running, it must be ensured that the simulation is processed within 5
seconds. If this time is exceeded, no image is transferred for this driver.

VALUE SIMULATION

Value changes are not transferred immediately, but stored in a buffer. The size of the buffer amounts to
8192 value changes or the five time the number of variables, according to whatever value is greater. The
delay in transferring resulting from the driver cycle can be up to 100 ms. If the value changes again
whilst it is waiting to be transferred, all values that have not yet been transferred are sent to Runtime
and the new value is then noted. This can lead to an increased load for the computer and network, but
ensures that all values are transferred in Runtime.

DRIVER WRITE COMMAND

If simulation - programmed is configured and active, the write commands at standby are passed
through in Runtime.

Write operations are carried out by the driver asynchronously to Runtime. Data is exchanged via a
buffer. The size of the buffer amounts to 8192 value changes or the five time the number of variables,
according to whatever value is greater.

Write commands are ran through after their values are changed in Runtime. If a write command cannot
be executed correctly, the error message Write queue full! Write command for <DP-Name> lost! i
displayed.

If the status bits are activated, setting Writing successful will display if the value was written
from the driver to the value of the variable. The Runtime program should delete this status again after
processing the write command. A status bit that is already active does not cause any delay in the driver
writing again. Write commands are also executed if the Runtime program was stopped by a breakpoint.

25



Note: Not all write commands from the driver must be visible in Runtime. If several write commands
are in the buffer,only the last one is visible in Runtime.

SWITCH OFF VARIABLES, SWITCH TO SUBSTITUTE VALUE

If the variable is switched off or switched to a substitute value, this is not recognizable for Runtime.
Changes in values that are also carried out by Runtime are not assigned to the variables in the driver. If
the variables are again switched to spontaneous value or activated, the current value is again carried
over from Runtime to the driver. When turning off the spontaneous value, status bit OFF is set. When
you switch back to the spontaneous value, the OFF bit is reset.

54.5 Data storage

RETAIN DATA

Retain data is stored in the simulRt<TreiberID>.ret file. One file such as this is created per simulation,
provided retain variables are present. The file is taken into account when a comparison is carried out in
the network.

DRIVER REMANENT

The simulation - programmed setting at the driver start is not a criterion in order to restore the
remanant variable image.

5.4.6 Redundancy

START ON THE STANDBY SERVER

If the driver is already running on a Standby Server, then the image for the simulation should already be
available. In this case, the simulation is started "hot" with this image. If there is no image, a warm a start
is carried out.
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TRANSFER DRIVER SIMULATION IMAGE TO STANDBY FUNCTION

This function is only executed on the Standby Server (for configuration, see Cyclical comparison (on page
17) chapter). The data is synchronously fetched from the driver on the server that is compiling the
image. The driver has 5 seconds of time for this. Because the data for the image is created in the same
thread in which the simulation is running, it must be ensured that the simulation is processed within 5
seconds. If this time is exceeded, no image is transferred for this driver.

SYNCHRONIZATION

In addition to the program files of the simulation, the following are also compared:

» Retain data (*.ret)

» all *.simul files
This file extension is created by the simulation program for simulation specific files and archived

in the folder with the computer description below the Runtime folder.

5.4.7 Status

STATUS SIMULATION

For the status simulation, in straton under Project -> Project parameters -> Extended -> Compiler -> Options ->
Create status bits for variables with a profile must be active. If the status of a variable is modified, this
triggers the transmission of a variable to the driver.

Changes to the following states does not trigger a value change at the driver and is also not taken over
from the simulation:

» Real time external (T_EXTERN/_VSB_RT_E)

» Real time internal (T_INTERN/_VSB_RT_I)

» Standard time (T_STD/_VSB_WINTER)

» Writing acknowledged (WR_ACK/_VSB_WR_ACK)
» Writing successful (WR_SUC/_VSB_WR_SUC)
» Normal status (NORM/_VSB_NORM)

» Deviation from normal status (N_NORM/_VSB_ABNORM)

27



» Select in the network (NET_SEL/_VSB_SELEC)
» Runtime exceeded (TIMEOUT/_VSB_RTE)

» In process (PROGRESS/_VSB_DIREC)

» Switched off (OFF/_VSB_N_UPD)

» Substitute value (ALT_VAL/_VSB_AVALUE)

¥ Information

State bit Writing successful (WR_SUC/_VSB_WR_SUC) is available in the

Runtime program and can be set back in order to display successful writing.

However only setting back the state does not trigger the transfer to the
<CD_PRODCUTNAME> Runtime. Only value changes are transferred from the driver to
the Runtime.

STATUS BITS HANDLED DIFFERENTLY

The following status bits cancel each other out:
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Bit Description

17: Spontaneous Status Spontaneous is set. This is the status set if status handling is
(SPONT/_VSB_SPONT) turned off or no status was defined. Status GI + INAVLID is deleted.
18: Invalid Status INVALID is set. Status SPONTAN + GI is deleted.

(INVALID/_VSB_|_BIT)

16: General query Status General queryisset. Status SPONTAN + INAVLIDis
(Gl/_VSB_GR) deleted.

8: Select in the If this status bit is active (BSO activation/deactivation) the following
network status bits are accepted with 0 and also transmitted as O to the driver to
(NET_SEL/_VSB_SELEC) identify a change:

» Select in the network (NET_SEL)
» Cause of transmission (COTx)
» Select (SE_870)

» N _CONF (P/N-BIT)

» Test bit (TEST)

» Writing successful (WR_SUC)

SELECT BEFORE OPERATE (SBO)

Status simulation must be available in the Runtime program in order for Select Before Operate to
be reacted to. The procedure for Select Before Operate is defined in Runtime.

ACTIVATION

If a SBO select is sent to the driver, it triggers a value being written with state Select in the network
(NET_SEL) + cause of transmission (COT_act).

A corresponding SBO procedure must be implemented and must start in Runtime.

The state bit Select in the network (NET_SEL) must be set back in the Runtime program.

DEACTIVATION

The deactivation triggers the writing of a values with status Select in the network (NET_SEL) + Cause of
transmission (COT_deact).
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The SBO procedure must be ended in Runtime accordingly.

The state bit Select in the network (NET_SEL) must be set back in the Runtime program.

5.4.8  Start/stop

DRIVER START

The value updating only starts at the Standby Server if the driver has received the process image from its
server. The image must be received within the time out module, otherwise the driver will start without
an image. If the Standby Server is upgraded to the server within the waiting waiting time, waiting is also
ended. Drivers that start in a network project or without a network have no waiting time. This behavior
applies for both the simulation as well as for the hardware mode.

RUNTIME START

If the driver starts the simulation - programmed, the first stage is loading the DLL with the simulation
Runtime. After this, Runtime is parametered and the Runtime program starts, provided it can be
successfully loaded.

If an image of Runtime is present, Runtime is started hot with this. Otherwise, a warm start is
carried out. If this is also not possible, an attempt is made to start Runtime cold. If there is no valid
program, Runtime boots up stopped. The status of all variables is set to INVALID.

The simulation program runs in it own thread and is therefore completely independent from the driver
cycle.

¥ Information

Retain variables

Retain data contain only the value of the straton variables not their status. This means

for the start:

»  Warm start: The status which was set for a variable is restored - regardless of whether it is a retain

variable or not.

»  Cold start with retain variables: Only the value of the retain variable in straton is restored, not the

status.

30



STOP RUNTIME

If Runtime is stopped, the status INVALID is set for all variables. Variables that are requested when
Runtime is stopped have the status INVALID as initialization. Runtime secures the data for the warm
start and online change:

» SIMULRT.HOT: contains the data for the hot restart.

» SIMULRT.UPD: contains the data for the online change.

Both these files are created in the Runtime program folder. Runtime must have write authorization for
this folder.

RELOAD

» Recompiling the simulation project:

causes the corresponding driver to be reloaded.

» Modification of the Time Out module:

is not recognized as a change by Runtime and does not cause the driver to be reloaded.

Standard implementation in the driver kit triggers a hot restart when reloading the simulation project. If
this is not possible (for example because the program is different), a cold start is carried out with
retain.

REMOVING RUNTIME

If Runtime is running, this is stopped. Before Runtime is removed, all outstanding value updates are sent
to the driver. Only then is Runtime released and SimulRuntime.d11 removed from the PC.

5.4.9 Driver commands

Driver commands are used to influence drivers via zenon, e.g. start and stop.
The engineering is implemented with the help of function briver commands.

STOP/START DRIVER

If the driver is stopped in simulation - programmed mode, this will result in Runtime being removed
from the memory. All variables obtain status 1nvaLID. When the driver is restarted, the simulation is
reloaded and Runtime is started.
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SWITCH HARDWARE/SIMULATION DRIVER

When switching between modes Hardware and Simulation, the driver behaves according to the
following pattern:

1. If the driver was configured for hardware mode in the Editor:

e the driver is set to mode simulation static after function priver command is executed
with parameter Driver in simulation mode.

2. |If the driver was configured in the Editor for one of the simulation modes (static, counting,

programmed:

e the driver is set to hardware mode and communicated with the control after function
Driver command iS executed with parameter Driver in hardware mode.

e the driver then changes back to the configured simulation mode after function priver
command Was executed with parameter Driver in simulation mode

5.4.10 Variable assignment

The zenon driver is allocated to the straton variables via the names converted into capital letters. If the
zenon Runtime requests a variable from the driver, it forwards this to the simulation. If no simulation is
loaded, the variable receives status Switched off ( OFF/VSB_N_UPD) when the driver is stopped.
Otherwise it receives status Invalid (INVALID/_VSB_I_BIT) . Variables of driver variable object type
are never requested by the simulation.

5.4.11 Time stamp

To use the time stamp, in straton under Project -> Project parameters -> Extended -> Compiler -> Options
->Statusbit create for variables with profile must be activated.

If in the Runtime program, the date for a variable is set, the value of the date and time is used as the
time stamp. When the date or time changes during the last cycle, this always triggers a transfer of the
value to the driver. This also applies if neither the value nor the status have changed.

Most drivers only transfer a new time stamp if the value and/or status change at the same time. An
example of an exception is the IEC870 driver, which also transfers new timestamps from the hardware
(or simulation - programmed) with the same value and same status to Runtime.
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Y Information

It must be ensured that the date and time always increase. If this is not the case, this can

lead to problems when archiving. The date must be a value greater or less than 0.

Variables stamped by the Runtime program receive the status Real time external
(T_EXTERN/_VSB_RT_E).

All variables to be transferred to the driver that are not stamped by Runtime receive a joint time stamp
in the cycle. This ensures that the time corresponds to that of the change. These drivers receive the
status Real time internal (T_INTERN/_VSB_RT_I).

DATE & TIME

The following applies for all date and time information:

» Times are UTC.
» All times must be between 02. 01. 1970 and 2038.
» Dates are converted into a string in the format YYYY/MM/DD.

» The time is converted into the format HH:MM:SS.

5.5 Pleas not for variables in simulation projects
The following is true for the creation and modification of variables in simulation projects:

1. straton

If variables are created for a simulation project in the straton Workbench, they do not have a
valid addressing for the communication. If the communication is switch to hardware, the
communication can be interrupted when the new variables are used in screens without a
adjusting the addressing correctly.

2. Rename

If a variable is renamed in a simulation project, the name of the variable is also changed in
zenon accordingly. So for example you must adjust the names of variables which are used
in a VBA project also in the VBA code.

3. Integrated solutions
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Variables of integrated solutions such as straton, IEC870 or IEC850 must not be renamed in
the simulation project. In this case the variables lose their project information.
For example: If you rename project0/Global/NewVar {0 myNeVariablenwVar in the simulation

project, it becomes myNewvar in zenon. After the renaming a communication with the straton
Runtime is impossible.

4. Communication based on variable names

Variables of a driver which communicates based on the variable names must not be
renamed in the simulation project.

5. Deleting or importing variables

If a variable is deleted or imported while online change is activated in straton, all variables
are removed and inserted again in straton.

6. Variables with active "embed" symbol

Variables which exist in a program and whoses "embed" symbol is active are not available
via the Shared Memory interface in zenon. If a variable with an active "embed" symbol is
moved from the global area to a program, the variable is deleted in zenon.

5.6 Error messages

Engineering in the zenon Editor
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Error message

The choosen name is already used for
another driver or contains invalid
characters! Please choose a different
name.

The simulation project from the <File
name>/<Description> driver has not
been compiled and cannot be supported!
Please compile the project in
Workbench.

Write queue full! Write command for
<Name Variable> lost!

Cause and solution

The new name of the simulation project is already used in the
project or is not valid.

» Give it avalid name

A simulation project is available for the driver in Workbench. This
was not compiled however.

> Start the straton Workbench with this driver's simulation project
>  compile the project

Hint: | does not make a difference if the diver settings are set to
simulation - programmed in the driver settings

Displays the loss of a write command.
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